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About Delga Press

As one the UK’s leading packaging printers, Delga Press Limited 
provide innovative, bespoke solutions to a variety of industries 
across the country and in Europe. Established for over 50 years, our 
expertise include carton design and print solutions using the latest 
digital and litho print technology all in-house.

About This Guide

The purpose of this document is to enable those who are new to 
packaging to create and supply print-ready artwork first-time to avoid 
delays and potential costs for re-supplies. We have included a brief 
overview of our workflow and the steps necessary to design the perfect 
packaging for your product.

Please take the time to read and understand the appropriate sections 
that apply to your order.

Enquiry to Order Sequence

At Delga Press, we design the structure of your carton, print and finish all in-house. It is essential 
that we understand the purpose and use of your carton to meet your expectation, and typically 
this is achieved following the below sequence of steps:
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Introduction

Keep 
Informed

For the latest version 
of this guide and other 

updates from Delga, 
please register at 

guidelines@delga.co.uk

*Production schedules will vary for each product/order and are subject to 
availability of materials. If you have a target date in mind, please include the details 
at the initial stages.

Specify Agree dimensions, style, materials, colours, finishes and volume.

Ensure the intended specification is within your budget.

Carton is designed and a white sample is sent you for approval.

Confirm the order and we shall send you the template drawing.

Submit your print-ready PDF for proofing.

Print manufacturing is scheduled*

Estimate

Sample

Order

Artwork

Produce

1

2

3

4

5

6



Inputs

Your artwork should be set to the size of the template 
drawing. The template is the key to how your carton will 
be produced and therefore understanding of the layout is 
crucial at this stage (as the drawing is flat it can often be 
disorientating). We recommend creating a 3D mock-up so 
you can understand the final position of each panel, and 
use your approved white sample as reference. For most 
products, we can provide a printed, CAD-cut prototype 
as part of the proofing process.

PDFs

This guide will help create your print-ready PDF, which 
upon submission, we shall check and verify against 
your order. Note: these checks are automated and does 
not involve proof-reading or evaluation of orientation, 
live matter or design content. Ensuring colour settings, 
overprint, margin infringements and overall appearance is 
the responsibility of the designer/client.

Outputs

We include a PDF proofing process as standard for all 
customers and shows you the artwork after we have 
processed it through our system. We can also send hard-
copy proofs, such as contract colour proofs or printed 
prototypes for an additional cost.

Inputs

Not all clients require us to design their carton, but for 
those that do, best practice is to supply the contents or 
products that the carton will hold. As well as ensuring 
the end result will be fit-for-purpose, we may be able 
to advise on alternatives styles depending on how the 
packing will be used.

If you have an existing design, we require the template 
drawing along with the specification. If you have had the 
product printed before, it is recommended to send us a 
previous example along with the template drawing.

Design Specification

This will include the dimensions, material to be used as 
well as the purpose of the carton. When considering a 
design, it is important that our team knows what happens 
to the product after it has been packed, as well as how it 
is packed.

For example, is the product packed into the carton by 
machine and/or will it be sent directly to a consumer 
through the post?

Outputs

We will produce a white sample representation of the 
final product for every new design - including those that 
you may have previously ordered elsewhere. The sample 
must be approved before drawings are released and 
production commences.

When you have placed your order, you can use our 
drawing to set your artwork design. See Working with 
Templates in this guide for more information.
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Carton Design Process (CAD)

Artwork Process

Supplied
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Specification

Carton
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Template
Drawing

Supplied
Drawing

Supplied
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Inputs Outputs

Print-Ready
PDF

Delga
Pre-flight

&
Check Production

Template
Drawing

Supplied
Drawing

Inputs Outputs

Design

Proof

Delga’s in-house team of skilled design engineers are the architects of your order and provide 
the foundation of the entire carton manufacturing process. Artwork cannot be finalised until the 
template drawing (die-cutting guide) is complete.

For new cartons, you will require our template drawing to finalise your print-ready PDF. This guide 
contains information on how to achieve the correct result first time and the diagram below is a brief 
outline of the steps undertaken at Delga Press when your PDF is received.
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Common errors

File Format and Colour Settings

Helpful Resources

Proof-read your document?

Checked colours are CMYK (not RGB)?

Checked your images are minimum 300dpi?

Checked that the template is overprinting?

Added 3mm bleed allowance?

Embedded your fonts?

Saved your artwork as a print-ready PDF?

Quick Check
Before sending us your artwork, have you:

File format must be print-ready PDF (native files such 
as Illustrator, Photoshop, InDesign may incur conversion 
costs). Colour profiles can be useful to help you 
understand how your design will look. We recommend 
your document colour settings are Euroscale Coated V2, 
or Coated Fogra 39.

Colour mode must be CMYK or set as spot colour for 
Pantone colour work. RGB images must be converted 
prior to PDF submission. Spot colours not used must be 
converted to CMYK or removed,

Your final print-ready PDF file should include crop marks, 
bleed areas, trim boxes and will also govern the quality of 
your images.

Vector and Raster Images
Prior to creating your PDF, it may be worth considering 
how you ensure your images will be at optimum quality. 
Many images are created using a series of dots/pixels 
which are called raster images - CMYK images should be 
set to at least 300 dots per inch (dpi). They do not scale 
up in size without a loss of quality, therefore we do not 
recommend using images above 100% of their size.

Format PDF/X-1a

Colour: CMYK (or Pantone colours as per ordered)

Images above 300dpi

Fonts embedded

Trim box specified

Overprint settings checked

Template included (see Working with Templates)

www.ppa.co.uk The site offers settings for the most common design applications as well as brief explanations of 
how to co-ordinate your workflow. Look for the Pass4Press or Pic4Press links for more detailed 
help at www.ppa.co.uk/resources/resources/ppa-production-resources. 

www.gwg.org There are many expert and up-to-date sources of information available online such as the Ghent 
Workgroup www.gwg.org which is perhaps the best source of advice available in achieving a 
correct print-ready file.

7 Trim-box not set

7 Images not 300dpi or above

7 Fonts not embedded

7 No bleed

7 Carton/Packaging not supplied in template

7 Template not set to correct colour

7 Template not set to overprint

7 Print/Varnish free areas not specified

7 Total Area Coverage (TAC) above 320%

PDF Specification

When saving raster images (usually Photoshop), we 
recommend as little compression as possible such as 
maximum quality JPEG or TIFF formats.

Vector images are different, as they are shapes and paths 
that can be mathematically scaled within the software. 
Typically, text, logos, borders etc are all vector format, 
and can be infinitely scaled without loss of quality.



Black Ink
Often, for larger areas, ‘rich’ blacks are used with a 
combination of all four CMYK colours. This creates a much 
deeper colour, but should not be used for text, barcodes 
or small objects.

The image below shows how using rich black can cause a 
fuzzy, sometimes blurred result.

If your design contains large areas of black, it could result 
in a ‘washed-out’ eff ect. We recommend making the 
colour 50% Cyan and 100% Black to strengthen it. You 
should not create solid black areas made from all four 
CMYK colours (known as 400% or registration black). as 
it results in too much ink when printed. Note: our limit is 
320% Total Area Coverage (TAC) - above this your fi les 
may be rejected.

Neutral Colours
Large areas, or solid backgrounds that are made up of 
more than two process colours can sometimes change 
due to print machine tolerances. This is due to the printing 
process which consists of small dots intersecting and 
overlapping to create coloured shapes and images.

Fig.1 shows a magnifi ed pattern formed by the four colour 
process print dots. Notice there are some white areas 
equal to the size of the pink (magenta) dots, which helps 
to achieve a neutral colour.

The printing process has a degree of movement between 
the colours which can change the dot pattern. Fig.2 
shows how a slight amount of movement to the magenta 
ink can aff ect the white areas. We therefore recommend 
that background colours are made up of two or three 
CMYK colours, which reduces the eff ect of print register 
tolerances.

Mono Images
For mono (black and white) images, we recommend that 
they are set to black only (greyscale). Due to the movement 
of the printed dot pattern (see Neutral Colours), mono 
images consisting of four process colours (CMYK) can 
sometimes appear with a green or pink colour cast, and 
may vary throughout the order.

Text Size and Rule Weights
If your design uses lines, rules or borders, they should be 
set to a minimum of 0.5pt and ideally be made from a 
maximum of two or three CMYK colours.

Regular or bold typefaces should be set as a minimum 
size of 6pt if printed in colour, and 5pt if 100% black.

Similarly, if you are using a light or fi ne typeface, it should 
not be below 10pt if in colour, or 8pt if 100% black.

Reverse-out text should not be set in light or fi ne 
typefaces below 24pt, depending upon the background 
colour. Regular weight typefaces are likely to be aff ected 
by print register tolerances, so for reverse-out text should 
be as bold as possible, especially when the background is 
more than two colours.

What is Bleed?
Bleed refers to the area of printed board that is trimmed 
when making your fi nished product. Artwork must include 
bleed if your design extends to the edge of the printed 
product.

If bleed is not allowed for, you are likely to see small white 
spaces at the edges of your fi nished product. We include 
a bleed guide within our template drawings, and a visual 
guide on page 11 of this document.

What is Overprint and Knockout?
Within your design software, you will fi nd settings such as 
‘overprint’ or ‘knockout’ - typically under Attributes. This 
setting determines how an object interacts with another 
and how it appears when printed.

The above image show how three shapes appear when 
set to knockout or overprint - note the white shape has 
disappeared. As a rule, white areas should knockout and 
black areas should overprint.

Please also see guidance on special fi nishes and white ink 
for more overprint advice.
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Design Advice
The advice in this section will help you get the best from your printed product. Your 
design is unique, but the following tips are often overlooked.

Rich Black100% Black

Knockout Overprint

fi g.1

original printed

fi g.2
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DELGA PRESS

JOHN SMITH

SAMPLE CARTON

CAD1521

01/01/2019

CRASH-LOCK BASE CARTON

149236

3

CUSTOMER:

CONTACT:

TITLE:

CAD REF:

VERSION:

QUOTE REF:

DATE:

DESCRIPTION:

MATERIAL:

ORIGINAL GRID REF:

CUTTER REF:

NOTES:

CAD NOTES:

Print-ready artwork for die-cut products must include a template for cutting and creasing. The 
guidance in this section will help you to work with drawings supplied by Delga, and how to include 
them in your fi nal print-ready PDF.

Using the Template File
To use the fi le eff ectively, it should remain as a vector fi le 
as it will need to be converted to a spot colour and set 
to overprint. Once complete it can be imported into your 
InDesign document or used as a layer within Illustrator.

To do this we recommend opening the PDF or .ai from 
within Illustrator - DO NOT place into the document as 
you will not be able to edit the objects.

Step 1 Create spot colour swatch 
to diff erentiate the drawing when 
fi nalising your design. In this 
example, we have used a bright 
pink, and called it ‘CUTTER’.

A spot colour is necessary as 
our workfl ow will separate the 
drawing from the artwork that is 
to print onto your product.

Step 2 Many of the objects 
will appear as an editable black stroke. To change the 
colour, simply select any one of the black lines, then go 
to Illustrator’s helpful ‘Select’ menu, go to Same, and 
the Stroke colour. Now ALL black stroke elements are 
selected. Note: you may wish to group them together to 
easily reselect them.

Step 3 Now you can change the colour to the new 
CUTTER swatch. You must then ensure the objects are 
set to overprint in the Attributes window, otherwise the 
drawing will leave white areas across your artwork.

Once complete, either move the entire template to a new 
Layer within Illustrator or you may wish to import as a 
vector image into other applications.

If Delga have designed your product a PDF fi le and/or an 
Adobe Illustrator (.ai) fi le will be sent to you when you 
have placed your order. The fi le contains the drawing’s 
dimensions, crease/perforation lines, as well as bleed and 
print-free areas.

Before placing over your artwork, please ensure the 
correct template reference and version match the sample 
you have approved. When your artwork is received we 
shall use the references to ensure it relates to your order.

Working with Templates

NOTE: You are NOT permitted 
to amend the drawing. 
Changes must be 
submitted to Delga for 
re-sampling and a new 
drawing and CAD REF 
will be supplied.



Adding Crop Marks in Adobe InDesign

Adding Crop Marks in InDesign works in a similar way to 
Illustrator but involves a few more steps.

Step 1 Draw an object with no fi ll or stroke to the size of 
the fl at carton - for our example it is 437.5mm wide and 
306mm high.

Step 2 Position the object to the edges of the fl at carton 
- take care not to position it to the bleed area.

Step 3 You will need a Script to produce the crop marks, 
in the Window menu Utilities and select the Scripts
window. With the object selected, fi nd the Crop Marks
script and double-click to create them.

Step 4: When prompted, 
we recommend you do not 
change the default Crop 
Marks options, however 
you should uncheck the 
Registration Marks option.

Click OK.

You will now have eight 
trim marks surrounding 
the corners of your carton. 

Note: InDesign has now 
created rules for each 
crop mark, and also built a 
new layer for them called 
‘myCropMarks’. 

Adding Trim Marks in Adobe Illustrator

Step 1 Draw an object with no fi ll or stroke to the size of 
the fl at carton - for our example it is 437.5mm wide and 
306mm high.

Step 2 Position the object to the edges of the fl at carton 
- take care not to position it to the bleed area.

Step 3 With the object selected, go to the Object menu 
and select Create Trim Marks.

You will now have eight trim marks surrounding the 
corners of your carton. 

7

One of the most common issues when processing artwork fi les is incorrect or unspecifi ed trim 
boxes, and if your artboard or document size matches to fl at size of the carton it is automatically 
set when creating your print-ready PDF. If your design is set within a larger area, you MUST add 
appropriate trim marks or crop marks for our software to detect the printed items.

How to set the Trim Box
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TIP: For those using layers (as described elsewhere 
in this guide) we recommend you move the crop 
marks or trim marks to the same layer as the 
template. Note: the object used to create them 
still remains, but can be deleted if you wish.
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Foiling
Hot or cold foil blocking is the process of ‘stamping’ foil 
onto the surface of the print. Though there are many 
colours of foils available, they are usually metallic and add 
a degree of luxury to the design. To stamp the foil, a metal 
block is cast from your artwork, but there are limitations 
to what can be achieved.

Intricate details such as small type or raster images cannot 
be foiled due to the stamping process. For best results, 
send your design to us for review before you create your 
fi nal print-ready PDF.

Embossing is the process of pressing an area into the 
reverse side of the substrate creating a ‘3D’ image on the 
front side. Debossing is pressed into the surface, making 
the image appear to be on lower level,

Embossing and Debossing
As with foil, a cast is made of the graphic and though 
there are limitations, they vary depending on the type 
and thickness of material. Small text and other fi ne 
details will not be visible, as the thickness of the material 
prevents the pressing of the die. We recommend that the 
details embossed are at least three times as thick as the 
substrate, but considerably more for rigid stocks.

Spot Varnishes
As well as ‘overall’ varnishes, which add a sheen or light 
coating to the printed surface, we can also apply a higher 
density varnish to highlight areas of your design.

The most common is Spot Gloss UV varnish, which works 
well in contrast with matt or solid backgrounds.

Lamination
The printers term for applying a layer of plastic fi lm to 
the surface of the sheet is laminating. The fi lms are most 
commonly gloss or matt, and are applied after printing 
and create a waterproof surface.

Many more laminations are available such as soft-
touch, textured, holographic and anti-scuff , which is a 
recommended alternative to matt for high-end products.

This graphic illustrates how the print and special fi nishes are 
applied to the material. It may be useful to emulate these layers 
when preparing your artwork.

Printed packaging can benefi t from additional processes such as foiling, spot varnishes, embossing 
and debossing. These common special fi nishes are great ways to accentuate aspects of the print, 
and here are some tips that should be considered when creating your artwork.

Special Finishes

Spot Gloss UV

Foil

Foil

Foil

Foil
Foil

Foil

Spot Gloss UV

Emboss

Emboss

Spot Gloss UV

Spot Gloss UV



Now that the foil 
objects have been 
separated, you are 
able to view the 
printed elements by 
turning off  the layer. 
Notice how the items 
beneath the foil are 
simple shapes, only 
part of which will be 
revealed by the foil.

The foil elements are 
now complete and are 
ready to supply for 
print. Once approved, 
we shall use the foil 
colour to create the 
block for production.

Repeat

These steps should be repeated for embossing, debossing 
and spot UV. Using diff erent colours for each fi nish is 
helpful, though it may not look like the fi nal result, it will 
help you to check the objects and layers are correct.

As with all artwork, we recommend checking your fi le with 
Overprint Preview - (go to View > Overprint Preview).
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Your print-ready PDF must separate the objects that require the special fi nish. In most cases, they 
will be a vector image and MUST be set to overprint as an additional spot colour, see our below 
guide on how to achieve this within your artwork fi le.

How to supply artwork for special fi nishes

To start, let’s describe what we’re trying to achieve. This 
design is to be printed four colour process (CMYK), is 
gold foiled, spot UVed and embossed.

In this example, the template drawing has been changed 
as described in the section ‘Working with Templates’ of 
this guide. We now want to make the foiling area a layer 
of its own. Note: we are using Adobe Illustrator.

Step 1 The foil artwork is set as 
a gold spot colour (5th colour) 
and set to overprint. We have 
called it ‘GOLD FOIL’.

Step 2 Create a layer for the foil, 
separate from the rest of the 
design. While this is not essential, 
it can help you view the design 
and ensure the objects are set 
correctly.

Step 3 The foil objects must now be set to overprint so 
that it does not aff ect the rest of the design. 

Overprinting with foil is standard as they are opaque. Your 
design may require an exception to allow other elements 
to knockout the foil, however it is not recommended due 
to register tolerances.

TIP: Use vector artwork where possible, not bitmap 
fi les. Gradients, tints, and rasterized images 
cannot be used for special fi nishes. Fine details 
such as small type, reverse fi ne images should be 
avoided due to registration tolerances.

Without
Overprint
Preview

With
Overprint
Preview



Step 4 If white object is required to mask the coloured 
board and ‘underpin’ the CMYK print (such as a barcode), 
it will need to be set to overprint in the Attributes window.

When complete, it’s essential to check your settings with 
Overprint Preview turned on.

Implementing a White Ink Design

White-ink areas must be supplied in the print-ready PDF 
in a similar way to the spot-colours for special fi nishes 
previously described in this guide. The exception is that 
vector and raster image can be printed in white.

Note:  overprint and knockout settings are crucial to the 
result so please check your overprint preview prior to 
creating your PDF.

For this walk-through, we shall use artwork created in 
Adobe Illustrator. This ‘Crusher’ carton prints four colour 
process (CMYK) and White onto a silver foil board. The 
gold areas are yellow hues printed directly onto the 
board, and other areas are either white ink, or have white 
ink UNDER the coloured areas,

Step 1 Create a new spot colour 
swatch called ‘WHITE’. The actual 
colour can be white if you wish 
- here we have used a green for 
distinction on screen.

Step 2 For those using layers, we 
recommend creating a separate 
WHITE layer to aid this process.

Step 3 Now simply change the objects that appear as 
white to the new colour swatch. Note: if these items are 
set to knockout in Attributes, they will appear white and 
will not underpin other inks.

If you need to underpin a white object, ensure it is set to 
overprint as in step 4.
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How to supply artwork with White Ink

Overprint Preview

If printing onto coloured or foiled board, white ink is an eff ective way to draw attention to areas of 
the design. Conventional designs rely on the substrate to remain white through the lack of ink. If 
the material is coloured, the print-ready fi le must include a white channel to print onto it.

TIP: white ink is often essential 
if printing photos and barcodes 
onto coloured or foiled board.

Without
Overprint
Preview

With
Overprint
Preview
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Design Quick-Check

4

This summary page is useful for a fi nal check before submitting your print-ready PDF.

Get Familiar: You can download this 
dummy artwork in Adobe Illustrator 
or InDesign for free from our website 
at delga.co.uk.

Template - set to spot-colour and overprint.

Bleed - 3mm min. and watch out for 
intersecting panels and fl aps.

Trim Box - set crop/trim marks if the document 
or artboard is larger than fi nished size.

Barcode - ensure rich-black is NOT used, and 
include white ink if using coloured stock.

Special Finishes - use spot-colours for each 
process and set to overprint.

Overprint - check and check again!

Artwork Guideline Summary

BLEED
min. 3mm bleed

OVERPRINT
Turned off 

OVERPRINT
Turned on

BLEED
Intersecting panels

PRINT-FREE
Glue areas

TEMPLATE
Spot Colour

Set to Overprint

PRINT-FREE
Glue areas

BARCODE
100% Black (or darkest spot colour)

White background

TRIM BOX
Crop or Trim Marks included if 
artboard is larger than artwork

SPECIAL FINISHES
Spot Colour

Set to Overprint

LAYERS
Set by print processes to 

show/hide objects
SPECIAL FINISHES

Spot Colour
Set to Overprint
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Microns - unit of measurement for thickness of a material. 
1000 microns = 1 millimetre.

Overprint -  an image/shape/text that print using one 
or more colours on top of another image/shape/text, 
changing their appearance.

Pantone – a global colour library for used by the printing 
industry. Pantone Matching System (PMS) inks are often 
called spot or special colours as opposed to four colour 
(process) inks. 

Raster Image - photos and images that are made up of 
pixels (typically Adobe Photoshop files). Raster images 
are limited by their pixels (unlike Vector graphics) and 
cannot be enlarged without loss of quality.

RGB – a Red, Green and Blue colour space used for screen 
displays (web, television, video and camera). RGB colour 
cannot be used in the printing industry.

RTE - Reverse Tuck-End describes a carton with two 
tuck-flaps each on opposite panels of the carton.

Substrate - generic term for paper or board.

Same-panel Tuck - describes a carton with two tuck-
flaps each on the same panel.

Silk - white coated paper or board with a non-reflective 
(matt) finish.

Spot UV - a varnish able to be applied to selected areas of 
a printed surface, derived from the artwork.

Stock - the paper or board (substrate) to be printed upon.

Template - die-cutting guides or keyline drawing that 
indicate the size and cutting positions of a carton.

TAC - Total Area Coverage. The composite amount of ink  
in an area when printing in four-colour-process. Standard 
printing processes are limited to a maximum TAC value 
of 320%.

Varnish - a clear ink-like liquid (coating), applied when 
using coated substrates to the printed surface to protect 
or add an even finish. Sometimes called Aqueous coating 
or Seal.

Vector Image – computer-generated images, shapes 
and text that are able to be enlarged without any loss 
of quality. Vector graphics contain plotted paths to 
create the shape enabling the scaling to be calculated 
mathematically within the software.

WBB - white-backed board is a folding box board with a 
white uncoated reverse side.

Glossary
Bleed - the area of print which is trimmed when producing 
the final product.

CAD - computer-aided-design. Used at Delga to describe 
their in-house structural engineers.

Carton - term used to describe ANY die-cut board 
substrate that is folded to achieve its final form.

CMYK – Cyan, Magenta, Yellow and Black inks used for 
four colour process printing. Cyan (blue), Magenta (pink/
red), Yellow and Black (Key) are combined to make up 
colour artwork and images.

Crop marks (Trim marks) - rules/lines used to indicate 
the cutting edge of a printed sheet. Crop marks should 
NEVER appear in the live area of the artwork.

Deboss - to press the substrate with a tool to create a 3D 
shape that appears lower than the surface.

Die Cutting - to cut paper or board using a metal tool to 
form a shape or flat carton.

DPI – raster image resolution is measured in dots-per-
inch. Minimum standard is 300dpi if the image is used at 
100% size.

Emboss - to press the substrate with a tool to create a 
3D shape that appears higher than the opposite surface.

FBB - folding box board. Usually white coated one side, 
and white or cream uncoated on the other,

Foil - a think layer of metallic material applied to a part or 
all of the surface of the printed sheet.

Four colour process – colour printing using CMYK inks.

GC1 - industry term for white-backed board.

GC2 - industry term for cream-backed board.

Grain - the name given to the direction of the fibres 
that make up paper and board. Grain direction helps to 
determine a substrates strength and its resistance to 
folding.

Gloss - white coated paper or board with a reflective 
finish.

GSM - unit of measurement for weight of material. 
One metre square of 500 grams-per-square-metre 
stock will weigh 500 grams,

Knockout - images/shape/text that do not allow another 
image/shape/text to affect its appearance. 

Lamination - a thin plastic film applied under heat to the 
surface of a printed sheet. Lamination can be gloss, matt, 
soft-touch, textured and many other finishes.


